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Lesson 1 Overview

More often than not, a

drawing will require more

than just objects to fully

describe all of the information

that the drawing is meant to

convey. Text is used to add

labels, notes, numbering,

dimensions, and tables to

drawings to communicate their intent fully. In this lesson, you'll learn

how to add single lines of text to drawings using the TEXT command,

add multiple lines of text using the MTEXT command, manipulate text

styles and fonts, and change the properties of text in your drawings.

Then you’ll learn how to create and work with tables in AutoCAD, and

how to use an AutoCAD template to both simplify and standardize your

layouts.

The second half of this lesson focuses on how to add dimensions to

objects in AutoCAD. You’ll learn how to draw single linear dimensions
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using the DIMLINEAR command, as well as how to automate the

drawing of multiple linear dimensions at once utilizing the QDIM

command. You'll also gain an understanding of how to add dimensions

to nonlinear objects such as angles, arcs, and circles. The concept of

ordinate dimensions is also introduced as a method to further enhance

the range of options for dimensioning your drawings.

1.1 Explain how to change text fonts, styles, and
properties in AutoCAD
Text Properties 

READING ASSIGNMENT

Read this assignment. Then, read Chapter 7 of your textbook.

This section introduces you to some basic methods to add annotations

to your drawings. Annotations are basically textual descriptions that are

added to a drawing to identify things like the type, size, and location of

objects, or to add additional information that may be required to relay

information on design or construction and manufacturing requirements.

The most common types of annotations that you’ll create in AutoCAD

are text, dimensions, and hatching. Hatch is technically a Draw

command as opposed to an Annotation command, so replace with

leaders and tables.

Multiple annotation styles may be used in a single drawing to make it

easier for the viewer to identify separate elements and save different

text settings for use in your drawings, such as font, size, type,

orientation, justification, and more. For example, you could define a

style called “General Notes,” which uses a ⅛-inch text height in the Arial
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regular font; you could define a different style called “Title Text,” which

uses a ½-inch text height in the Arial bold font. You can also define

special characters that aren’t found on your keyboard but are commonly

used in drawings (such as the degree symbol).

There are two basic ways in which text can be placed into a drawing:

single-line and multiline. As its name implies, single-line text results in

one continuous line of text characters, with numerous options for placing

the text and multiple fonts and styles to choose from. Multiline text uses

a special text editor to create and place multiple lines of text within a

drawing. This option allows you to choose a window on the screen into

which the text will be placed. The size and shape of the box will

determine the number of lines of text that will be created, depending on

the font size and space available. Typically, multiline text is used more

frequently than single-line.

Once the text is drawn, it's sometimes necessary to make changes or

edits to the text. The TEXTEDIT command allows you to change the

wording and context of your annotations, and also provides a means to

modify text properties using height, justification, and character options.

AutoCAD even has a spelling checker, which is very similar to those

used in word processing programs.

Another way to modify objects including text is to utilize the

MATCHPROP command, which can be used to match the properties of

one object to another. For example, once you’ve annotated a drawing,

you may decide that you want to make a uniform text style to describe
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objects that share similar properties. Use MATCHPROP to do this: First,

select a source object with the properties you wish to transfer, then

select the destination object(s). You can also use the Property Settings

dialog box to pick the specific properties you wish to match. This is done

by selecting Settings from the command line while in the MATCHPROP

command.

As with other objects, you can modify the scale of the text if you wish.

This is done using the SCALE command. The amount you scale objects

up or down is driven by the scale factor you choose. Scale factors are

based on a unit of 1, so choosing 0.5 will reduce the scale by half,

whereas a scale factor of 2 will make objects twice as large. You can

also scale by Reference, which saves you time by having AutoCAD do

the math to figure out scale factors. You can also scale by highlighting

an object, picking a grip, right-clicking, and selecting Scale from the

shortcut menu.

Tables are used in drawings at times to add text for things such as parts

lists, bills of materials, and revision history. AutoCAD provides multiple

options for creating and managing tables and the data they contain.

Table styles can be created and saved. You can format table cells with

text, numerical data, formulas, and with fields that can be set up to

update automatically. Data can even be extracted from a drawing and

linked to an external spreadsheet.

Now that you have an understanding of both creating text and utilizing

paper space layouts, you can utilize AutoCAD templates to create
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predrawn borders and title blocks. A drawing title block typically includes

a border that represents the sheet size as well as textual information

such as name, address, drawing title, revision history, general notes,

tolerance information, and more.

Key Points and Links 

READING ASSIGNMENT

Key Points

The TEXT command is used for entering single lines of text, while

the MTEXT command is used for entering multiple lines of text

within a specialized text editor.

The TEXTEDIT command can be used to edit text created with

either the TEXT command or the MTEXT command.

All objects have characteristics called properties. Standard

properties include color, layer, linetype, lineweight, and length.

The AutoCAD SPELL command can be used to check the spelling

of text within your drawing.

The MATCHPROP command can be used to match all or some of

the properties of one object to another.

Exercise: AutoCAD: Annotations

Answer the “Chapter Test Questions” at the end of chapter 7 of

your textbook. This includes the “Multiple Choice,” “Matching,”

“True or False,” and “Questions.” You may also want to try the
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“Drawing Problems” on your own.

Exercise Answer Key: 

Exercise: AutoCAD: Annotations 

Multiple Choice

1. a

2. b

3. c

4. d

5. b

Matching

a. %%d

b. %%c

c. Contextual tab

d. A.M.

e. Grip Edit mode

True or False

1. True

2. False

3. True

4. False

5. False

AutoCAD Blocks and Layers (v1) : Lesson 1 : Page 6© 2020 Penn Foster
Inc.



Questions

1. Center-justified text is centered on the midpoint of an underline of

the text. Middle-justified text is centered on the midpoint of a line

running through the middle of the text.

2. The symbol %% identifies that the character that follows is to be

translated by its character code.

3. A font is a named set of characters, having common design

characteristics. A style, in AutoCAD, is a named set of text settings,

beginning with a font but also including other characteristics such

as height, width, direction, slanting, and so on.

4. Enter SCALE, select the line, pick a base point, specify the

Reference option, type 3 Enter, and then type 2.75 Enter.

5. Pick the New tool to create a new drawing; then select an AutoCAD

template with a border and title block from the template list.

1.2 Describe the methods of linear dimensioning
Dimensioning 

READING ASSIGNMENT

Read the assignment. Then, read pages 307–325 of Chapter 8 in your textbook.

In the previous section, you learned how to add annotations to a

drawing; in this section, you’ll discover how to dimension a drawing.

AutoCAD allows you to create numerous dimension styles with various
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types and sizes of leaders, arrows, and texts. It also lets you control

different variables such as units, precision, tolerances, and more. All of

these options are accessed through the Dimension Style Manager

dialog box, which allows you to create and modify existing styles and

even temporarily override some style features when necessary.

Whether you’re creating a new text style or modifying an existing one,

the dialog box will contain tabs for the various options, including Lines,

Symbols and Arrows, Text, Fit, Primary Units, Alternate Units, and

Tolerances. As you can see, defining dimension styles allows you to

maintain the consistency of the appearance of dimensions. By defining

styles in a template drawing, all drawings made from that template can

have a similar appearance.

AutoCAD provides tools to create linear dimensions, which can be

horizontal, vertical, or aligned with an object, as well as tools to create

dimensions for angles, arcs, and circles. Another very useful tool is the

Quick Dimension option that helps to automate the creation of multiple

dimensions. For instances when it's better to dimension features of an

object relative to a fixed point rather than point to point, the Ordinate

Dimension feature is available.

Key Points and Links 

READING ASSIGNMENT

Key Points

Dimension styles that control the text and geometry of different

types of dimensions can be created and saved.
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The QDIM command automates the creation of certain types of

multiple dimensions.

Ordinate dimensions are relative to a fixed point of origin rather

than point to point.

Exercise: AutoCAD: Dimensioning Drawings

In the “Chapter Test Questions” at the end of chapter 8 of your

textbook, complete “Multiple Choice” question 1, “Matching”

questions a–d, “True or False” question 2, and “Questions”

questions 1 and 3. You may also want to try the “Drawing

Problems” on your own.

Exercise Answer Key: 

Exercise: AutoCAD: Dimensioning Drawings 

Multiple Choice

1. c

Matching

a. Baseline

b. QDIM

c. DIMORDINATE

d. DIMANGULAR

True or False
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2. False

Questions

1. Dimensions have their own style, including unit type. To specify

architectural dimensions, you must create a dimension style with this

type of dimension.

3. Ordinate dimensions are measured relative to a point of origin. By

moving the origin of the coordinate system to a point in the drawing, you

can create ordinate dimensions relative to that point. In QDIM, you do

this by selecting the datum point option and then picking a point.

Lesson 1 Review

Self-Check 

1. What is the command that allows you to type multiple lines of text in a

special text editor and positions them in a windowed area in your

drawing? 

    a. TEXT 

    b. MTEXT 

    c. TEXTEDIT 

    d. TEXT2MTEXT 

2. Where are the text entry and editing tools located in the AutoCAD

user interface? 
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    a. In the Tools menu 

    b. Under the Insert dropdown 

    c. The Properties palette 

    d. In the Annotation panel on the ribbon 

3. What is the difference between center-justified and middle-justified

text? 

    a. Center-justified text is placed equidistantly between two specified

points, while middle-justified text is justified from the middle of the text

both horizontally and retains its vertical height. 

    b. Center-justified text is justified from the from the middle of the text

both horizontally and vertically, while middle text is justified from the

bottom center of the text block. 

    c. Center-justified text retains its vertical height while being justified

from the center of the text block, while middle-justified text is placed

between two specified points. 

    d. Center-justified text is justified from the bottom center of the text

block, while middle text is justified from the middle of the text both

horizontally and vertically, rather than from the bottom center of the text

block. 

4. What is the difference between aligned and fit text justification? 

    a. Aligned text is justified from the bottom center of the text block,

while fit text is justified from the middle of the text both horizontally and

vertically, rather than from the bottom center of the text block. 

    b. Aligned text is placed between two specified points and retains its

height relative to the distance between these two points, while fit text

proportions its height relative to the distance between the two points. 
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    c. Aligned text is justified from the from the middle of the text both

horizontally and vertically, while fit text is justified from the bottom center

of the text block 

    d. Aligned text is placed between two specified points and proportions

its height relative to the distance between these two points, while fit text

retains its original height when placed between two specified points. 

5. What is the procedure for entering angled text in AutoCAD? 

    a. Activate the TEXT or MTEXT command, pick a starting point, enter

text size, enter angle, enter text. 

    b. Activate the TEXT or MTEXT command, enter angle, pick a

starting point, enter text, enter text size. 

    c. Activate the TEXT or MTEXT command, pick a starting point, enter

text, highlight entry, enter text size, enter angle. 

    d. Activate the TEXT or MTEXT command, pick starting point, enter

text size, enter angle, enter text. 

6. What does %%P stand for? 

    a. Percent 

    b. Point 

    c. Plus/Minus 

    d. Parallel 

7. How is the MTEXT default formatting different from the Fit justification

format? 

    a. Both options allow for a body of text to be located within a specified

constraint field and are more or less redundant. 

    b. AutoCAD formats and justifies MTEXT entries according to the

specified field constraints but leaves Fit entries as simple text. 
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    c. MTEXT doesn't attempt to place the complete text width within a

specific window; it's concerned with the text height only. Fit also

addresses the width of the text block. 

    d. While Fit adjusts text height to allow the entire body of text to fit

within specified constraints, MTEXT doesn't attempt to place the

complete text inside the window, but only within its width. 

8. Selecting text and clicking Edit in the right-click dropdown

accomplishes the same task as _______ the text. 

    a. double-clicking 

    b. regenerating 

    c. reloading 

    d. re-entering 

9. Most object modification options can be accessed through the 

    a. Annotation palette. 

    b. Dynamic Input palette. 

    c. Gizmo palette. 

    d. Quick Properties palette. 

10. What command-line entry activates the SPELL command? 

    a. S 

    b. SP 

    c. SCHK 

    d. SPCHK 

11. How do you change the appearance of a body of text to run

vertically? 

    a. Use the Effects panel in the Text Style dialog box. 

    b. Use the ROTATE command to rotate the text 90 degrees. 
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    c. Resize the text window so that only one letter fits within it at a time.

    d. Create a series of single-letter TEXT entities and align them one

under another using the SNAP command. 

12. You've realized you've just spent three hours drawing cabinetry

elevations on the wrong layer and using incorrect lineweights/types.

What is the most efficient way to correct this mistake? 

    a. Go through the elevations and select the appropriate objects as a

set, then change their layer and linetypes manually in the Quick

Properties palette to the desired ones. 

    b. Select each object type set in its turn, hit Ctrl + X to cut it from your

drawing, navigate to the appropriate layer in your Layer Manager panel,

and paste the object set back into the drawing. Repeat as necessary. 

    c. Select each object independently in succession, and change the

properties in the Properties Manager one by one. 

    d. Use the MATCHPROP (MA) command to select the objects with

desired properties and then match the appropriate object types in your

cabinetry elevations to the source object. 

13. MA, select source object, S accomplishes what command

functionality? 

    a. Activates the Property Settings dialog box within the Match

Properties command 

    b. Activates the Object Snap function within the Match Properties

command 

    c. Activates the Save Property Presets function within the Match

Properties command 

    d. Activates the Setup function within the Match Properties command 
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14. You've downloaded a series of CAD objects from a manufacturer's

website, only to realize that they were drawn in millimeters, while your

drawing is in inches. What is the best way to remedy the situation? 

    a. Import the CAD objects into your drawing and use the Scale By

Reference option to size them to the required dimensions. 

    b. Contact the manuacturer's Support department and ask for

Imperial CAD blocks instead. 

    c. Scale the drawings up and down by percentages until you get to a

Good Enough, visually viable scale that matches your needs. 

    d. Look up "mm to in conversion tables" on the internet and scale the

drawings up or down accordingly. 

15. Your boss wants you to include door and window schedules on the

layouts for a multifamily apartment project. What is the best way to

handle organizing the different types, dimensions, model numbers, and

finishes of these items? 

    a. Lay out the schedule in Excel and import a PDF print to AutoCAD. 

    b. Draw a table by offsetting a series of lines or copying a series of

boxes in AutoCAD to simulate a spreadsheet. 

    c. Insert a series of spec sheets for each window into AutoCAD

layouts and tag each layout with a key on the main floorplan. 

    d. Draw a table with the appropriate number of rows and columns. 

16. When you need to reverse direction while moving sequentially

through a table, what keys should you press? 

    a. Shift and Tab 

    b.  Ctrl and Enter 

    c. Alt and Tab 
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    d. Space bar and Enter 

17. PlotScale, Date, PageSetupName, Project, and Title are all types of 

    a. functions. 

    b. smart elements. 

    c. dynamic variables. 

    d. fields. 

18. How do you set automatic field updates for your drawing? 

    a. Insert > Data > Update Fields 

    b. Pick Object > Right-click > Update Field 

    c. Right-click on empty space > Options > User Preferences >

Fields > Field Update Settings 

    d. Regen > Right-click > Update Field 

19. What is the primary purpose of a title block? 

    a. Provide a border that represents the sheet size as well as textual

information such as drawing title, revision history, and so on 

    b. To enhance the graphic appeal of the drawing set 

    c. To provide a frame for viewports to reside in 

    d. To organize filing and revision information for municipal authorities 

20. You have a last-minute project with an End of Day issuance. What is

the most efficient way to set up a title block? 

    a. Draw one from scratch. Title Blocks are unique to each project. 

    b. Download one from the internet. 

    c. Open and modify an existing AutoCAD template to tailor it to your

needs. 

    d. Just use a text field instead. 
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Self-Check Answer Key 

1. MTEXT 

Explanation: MTEXT allows you to type multiple lines of text in a

special text editor and positions them in a windowed area in your

drawing, similar to text editing options of MS Word or Apple's

Pages. It's a more robust tool than the simple TEXT command,

which only allows you to enter one line of text at a time. 

Reference: Section 1.1 

2. In the Annotation panel on the ribbon 

Explanation: All text entry and related options are found in the

Annotation panel of the ribbon. 

Reference: Section 1.1 

3. Center-justified text is justified from the bottom center of the text

block, while middle text is justified from the middle of the text both

horizontally and vertically, rather than from the bottom center of the

text block. 

Explanation: Center-justified and middle-justified justification

options differ subtly but have important effects on the layout and

overall look of your finished prints. Center-justified text is justified

from the bottom center of the text block, while middle-justified text

is justified from the middle of the text both horizontally and

vertically, rather than from the bottom center of the text block. 

Reference: Section 1.1 
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4. Aligned text is placed between two specified points and proportions

its height relative to the distance between these two points, while fit

text retains its original height when placed between two specified

points. 

Explanation: Aligned text is placed between two specified points

and proportions its height relative to the distance between these

two points, while fit text retains its original height when placed

between two specified points. 

Reference: Section 1.1 

5. Activate the TEXT or MTEXT command, pick starting point, enter

text size, enter angle, enter text. 

Explanation: Activate the TEXT or MTEXT command, pick starting

point, enter text size, enter angle, enter text, press Enter to close

out the command. It is also best to get into a habit of hitting Save

often, especially after completing some labor-intensive commands

like text entry, arrays, or hatching, which tie up a lot of AutoCAD

resources and sometimes force the system to crash. Saving often

after these commands will prevent data loss throughout your

process. 

Reference: Section 1.1 

6. Plus/Minus 

Explanation: AutoCAD has a robust library of control codes and

special characters at your disposal. %%p triggers a code command
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to display the Plus/Minus sign, ±. It's an important code you'll use

often when noting tolerances. 

Reference: Section 1.1 

7. While Fit adjusts text height to allow the entire body of text to fit

within specified constraints, MTEXT doesn't attempt to place the

complete text inside the window, but only within its width. 

Explanation: While Fit adjusts text height to allow the entire body of

text to fit within specified constraints, MTEXT doesn't attempt to

place the complete text inside the window, but only within its width.

As a result, you'll often need to backtrack and check whether your

text is fully displayed within your model or layout constraints.

Leftover text is signaled by a red icon locked into the right bottom

corner of your text column/field. 

Reference: Section 1.1 

8. double-clicking 

Explanation: Many of the same functionalities available in the right-

click dropdown can be accessed by simply double-clicking the

object in place. In this case, the TEXTEDIT command is activated

with greater efficiency than if you were using the dropdown method.

Reference: Section 1.1 

9. Quick Properties palette. 

Explanation: The Quick Properties palette is a universal tool

available for all AutoCAD object types, not solely text entities. It
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contains the properties listing and options for any selected object,

based on its type and its inherent characteristics. With text and

multiline text entities, the palette contains properties such as

justification, size, font, rotation angle, and any special formatting

effects such as strikethrough or superscript performed on the given

text block. 

Reference: Section 1.1 

10. SP 

Explanation: The SPELL command allows you to check spelling on

a body of text from within AutoCAD itself. The command-line entry

SP will save you significant time compared with navigating to it

through the menus. 

Reference: Section 1.1 

11. Use the Effects panel in the Text Style dialog box. 

Explanation: The Effects panel in the Text Style dialog box

provides a number of alterations you can perform to reformat

existing bodies of text. The Vertical option is one of the alterations,

and is the correct way to achieve the desired effect, while resizing

text windows and breaking up the text into a series of single letters

is a rookie workaround that creates a lot of extra labor. Rotating the

text will change its orientation but not its run direction. 

Reference: Section 1.1 

12. Use the MATCHPROP (MA) command to select the objects with
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desired properties and then match the appropriate object types in

your cabinetry elevations to the source object. 

Explanation: Using the MATCHPROP command by typing MA or

selecting the Match Properties icon from the Properties panel on

the ribbon is an efficient and sure-fire way to correct your course of

action, provided there are existing objects in the drawing with the

settings you desire. 

Reference: Section 1.1 

13. Activates the Property Settings dialog box within the Match

Properties command 

Explanation: The command sequence MA, select source object,

S activates the Property Settings dialog box within the Match

Properties command to allow you to specify the particular

properties you want to match between the objects, while omitting

ones you need to keep separate. 

Reference: Section 1.1 

14. Import the CAD objects into your drawing and use the Scale By

Reference option to size them to the required dimensions. 

Explanation: Drawing unit coordination can be eliminated through

the use of the Scale By Reference function of the SCALE (SC)

command. If you need a CAD object to be of a certain height or

width, simply draw a line with the desired dimension, align one of

its vertices with the part of the object you need to match in size,

and execute the following command sequence: SC, select object,
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specify base point r, pick the original object's start and end points,

then pick the new dimension endpoint on the line you've drawn

earlier.  

Reference: Section 1.1 

15. Draw a table with the appropriate number of rows and columns. 

Explanation: While the solution to lay out the schedule information

in a spreadsheet and then insert a PDF of that spreadsheet into

your layout may seem second nature, image files are much heavier

than AutoCAD vector objects and will balloon the size of your files,

reducing loading speed and maneuverability extensively. The

fastest and most effective solution is to draw a table directly within

AutoCAD and populate it accordingly. Drawing and offsetting lines

and boxes one by one not only delays the execution of the project,

but offers limited and cumbersome editability if anything changes

later on in the project. 

Reference: Section 1.1 

16. Shift and Tab 

Explanation: When entering data in table cells, you can move

sequantially through cells using the Tab key. To reverse direction

and move backward, hold down the Shift key while pressing Tab. 

Reference: Section 1.1 

17. fields. 

Explanation: PlotScale, Date, PageSetupName, Project and Title
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are just some of the field types available in the Field dialog box.  

Reference: Section 1.1 

18. Right-click on empty space > Options > User Preferences >

Fields > Field Update Settings 

Explanation: Automating repetitive tasks in AutoCAD is critical to an

efficient drafting workflow. Updating fields automatically removes

an extra level of coordination pressure from your daily drawing

schedule and saves time. To set your fields to update automatically

during specific conditions (printing a drawing, opening a drawing,

saving a drawing, etc), right-click on empty space, then click

Options > User Preferences > Fields > Field Update Settings. 

Reference: Section 1.1 

19. Provide a border that represents the sheet size as well as textual

information such as drawing title, revision history, and so on 

Explanation: A title block typically includes a border that represents

the sheet size as well as textual information such as name,

address, drawing title, revision history, general notes, tolerance

information, and more. 

Reference: Section 1.1 

20. Open and modify an existing AutoCAD template to tailor it to your

needs. 

Explanation: In a tight-deadline situation, it's always best to load the

already-available templates from AutoCAD's DWT library and
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modify them to your needs. 

Reference: Section 1.1 

Flash Cards 

1. Term: TEXT 

Definition: Command that allows you to type single lines of text and

displays them as you type

2. Term: MTEXT 

Definition: Command that allows you to type multiple lines of text in a

special text editor and positions them in a windowed area in your

drawing

3. Term: Aligned Text 

Definition: Text justification option that proportions text height relative

to the distance between the two points between which it's placed

4. Term: %%C 

Definition: The control code for the Diameter symbol

5. Term: Multiline Text Editor 

Definition: The panel type that gives you the ability to change text

styles, fonts, and other text features

6. Term: Properties 
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Definition: Characteristics of an object that determine how and where

an object is shown in a drawing; some are object-specific while others

are universally common

7. Term: Annotative 

Definition: The property of being automatically scalable to match the

varying scales of viewports in a drawing layout; typically refers to text

and dimensions

8. Term: Text Styles 

Definition: Variations in size, orientation, and spacing of characters

within given fonts

9. Term: MATCHPROP (MA) 

Definition: Command that increases drafting efficiency by letting you

match all or some of the properties of an object to those of another

10. Term: Basepoint Scaling 

Definition: The concept that allows you to specify whether, and which,

sides of a previously-drawn object will expand/shrink equally, and in

relation to which geographical location
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